Chapter 533

Superiority by a Margin Tests for the Ratio of Two Means in a Higher-Order Cross-Over Design

Introduction

This procedure calculates power and sample size for non-zero null tests which use the ratio of the two means of a higher-order cross-over design. Measurements are made on individuals that have been randomly assigned to one of several treatment sequences. Only a brief introduction to the subject will be given here. For a comprehensive discussion on the subject, refer to Chen et al. (1997) and Chow et al. (2003).

Cross-Over Designs

Senn (2002) defines a cross-over design as one in which each subject receives all treatments at least once and the object is to study differences among the treatments. The name cross-over comes from the most common case in which there are only two treatments. In this case, each subject crosses over from one treatment to another. It is assumed that there is a washout period between treatments during which the response returns to its baseline value. If this does not occur, there is said to be a carryover effect.

A 2x2 cross-over design refers to two treatments (periods) and two sequences (treatment orderings). One sequence of treatments is treatment A followed by treatment B. The other sequence is B and then A. The design includes a washout period between responses to make certain that the effects of the first drug do no carryover to the second. Thus, the groups of subjects in this design are defined by the sequence in which the two treatments are administered, not by the treatments they receive.

Higher-Order Cross-Over Designs

Chen et al. (1997) present the results for four cross-over designs that are more complicated than the 2x2 design. Assume that the two treatments are labeled A and B. The available designs are defined by the order and number of times the two treatments are administered.
Balaam’s Design

Balaam’s design has four sequences with two treatments each. It is popular because it allows the intrasubject variabilities to be estimated. The design is

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Period 1</th>
<th>Period 2</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>3</td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>4</td>
<td>B</td>
<td>A</td>
</tr>
</tbody>
</table>

Two-Sequence Dual Design

This design has two sequences with three periods each. It is popular because it allows the intrasubject variabilities to be estimated. The design is

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>B</td>
<td>B</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>A</td>
<td>A</td>
</tr>
</tbody>
</table>

Four-Period Design with Two Sequences

This design has two sequences of four periods each. The design is

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>A</td>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

Four-Period Design with Four Sequences

This design has four sequences of four periods each. The design is

<table>
<thead>
<tr>
<th>Sequence</th>
<th>Period 1</th>
<th>Period 2</th>
<th>Period 3</th>
<th>Period 4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>A</td>
<td>B</td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>A</td>
<td>A</td>
<td>B</td>
</tr>
<tr>
<td>1</td>
<td>A</td>
<td>B</td>
<td>B</td>
<td>A</td>
</tr>
<tr>
<td>2</td>
<td>B</td>
<td>A</td>
<td>A</td>
<td>B</td>
</tr>
</tbody>
</table>

Advantages of Cross-Over Designs

A comparison of treatments on the same subject is expected to be more precise. The increased precision often translates into a smaller sample size. Also, patient enrollment may be easier to obtain because each patient will receive both treatments.

Disadvantages of Cross-Over Designs

The statistical analysis of a cross-over experiment is more complex than a parallel-group experiment and requires additional assumptions. In a cross-over experiment, it may be difficult to separate the treatment effect from the time effect and the carry-over effect of the previous treatment.

These cross-over designs cannot be used when the treatment (or the measurement of the response) alters the subject permanently. Hence, it cannot be used to compare treatments that are intended to provide a cure.

Because subjects must be measured at least twice, it may be more difficult to keep patients enrolled in the study. This is particularly true when the measurement process is painful, uncomfortable, embarrassing, or time consuming.
The Statistical Hypotheses

Both non-inferiority and non-zero null tests are examples of directional (one-sided) tests. Remember that in the usual t-test setting, the null (H0) and alternative (H1) hypotheses for one-sided tests are defined as

\[ H_0: \phi \leq A \quad \text{versus} \quad H_1: \phi > A \]

Rejecting H0 implies that the ratio of the mean is larger than the value A. This test is called an upper-tailed test because H0 is rejected only in samples in which the ratio of the sample means is larger than A.

Following is an example of a lower-tailed test.

\[ H_0: \phi \geq A \quad \text{versus} \quad H_1: \phi < A \]

Non-inferiority and non-zero null tests are special cases of the above directional tests. It will be convenient to adopt the following specialize notation for the discussion of these tests.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>PASS Input/Output</th>
<th>Interpretation</th>
</tr>
</thead>
<tbody>
<tr>
<td>( \mu_T )</td>
<td>Not used</td>
<td>Treatment mean. This is the treatment mean.</td>
</tr>
<tr>
<td>( \mu_R )</td>
<td>Not used</td>
<td>Reference mean. This is the mean of a reference population.</td>
</tr>
<tr>
<td>( M_s )</td>
<td>SM</td>
<td>Margin of superiority. This is a tolerance value that defines the magnitude of difference that is required for practical importance. This may be thought of as the smallest difference from the reference that is considered to be different.</td>
</tr>
<tr>
<td>( \phi )</td>
<td>R1</td>
<td>True ratio. This is the value of ( \phi = \frac{\mu_T}{\mu_R} ) at which the power is calculated.</td>
</tr>
</tbody>
</table>

Note that the actual values of \( \mu_T \) and \( \mu_R \) are not needed. Only their ratio is needed for power and sample size calculations.

The null hypothesis of non-superiority is

\[ H_0: \phi \leq \phi_L \quad \text{where} \quad \phi_L > 1. \]

and the alternative hypothesis of superiority is

\[ H_1: \phi > \phi_L \]

Log-Transformation

In many cases, hypotheses stated in terms of ratios are more convenient than hypotheses stated in terms of differences. This is because ratios can be interpreted as scale-less percentages, but differences must be interpreted as actual amounts in their original scale. Also, taking the logarithm of the data can make skewed data closer to normal. Hence, it has become a common practice to take the following steps in hypothesis testing.

1. State the statistical hypotheses in terms of ratios.
2. Transform these into hypotheses about differences by taking logarithms.
3. Analyze the logged data—that is, do the analysis in terms of the difference.
4. Draw the conclusion in terms of the ratio.
The details of step 2 for the alternative hypothesis are as follows.

\[
\phi_L \leq \phi \\
\Rightarrow \phi_L \leq \left\{ \frac{\mu_T}{\mu_R} \right\} \\
\Rightarrow \ln(\phi_L) \leq \{\ln(\mu_T) - \ln(\mu_R)\}
\]

Thus, a hypothesis about the ratio of the means on the original scale can be translated into a hypothesis about the difference of two means on the logged scale.

**Coefficient of Variation**

The coefficient of variation (COV) is the ratio of the standard deviation to the mean. This parameter is used to represent the variation in the data because of a unique relationship that it has in the case of log-normal data.

Suppose the variable \( X \) is the logarithm of the original variable \( Y \). That is, \( X = \ln(Y) \) and \( Y = \exp(X) \). Label the mean and variance of \( X \) as \( \mu_X \) and \( \sigma_X^2 \), respectively. Similarly, label the mean and variance of \( Y \) as \( \mu_Y \) and \( \sigma_Y^2 \), respectively. If \( X \) is normally distributed, then \( Y \) is log-normally distributed. Julious (2004) presents the following well-known relationships between these two variables

\[
\mu_Y = \left( e^{\mu_X + \frac{\sigma_X^2}{2}} \right)
\]

\[
\sigma_Y^2 = \mu_Y^2 \left( e^{\sigma_X^2} - 1 \right)
\]

From this relationship, the coefficient of variation of \( Y \) can be found to be

\[
COV_Y = \frac{\sqrt{\mu_Y^2 \left( e^{\sigma_X^2} - 1 \right)}}{\mu_Y} = \sqrt{e^{\sigma_Y^2} - 1} = \sqrt{e^{\sigma_Y^2} - 1}
\]

where \( \sigma_Y^2 \) is the within mean square error from the analysis of variance of the logged data. Solving this relationship for \( \sigma_X^2 \), the standard deviation of \( X \) can be stated in terms of the coefficient of variation of \( Y \). This equation is

\[
\sigma_X = \sqrt{\ln \left( COV_Y^2 + 1 \right)}
\]

Similarly, the mean of \( X \) is

\[
\mu_X = \frac{\mu_Y}{\ln \left( COV_Y^2 + 1 \right)}
\]

Thus, the hypotheses can be stated in the original (\( Y \)) scale and power analyzed in the transformed (\( X \)) scale.
Superiority Tests

A superiority by a margin test tests that the treatment mean is better than the reference mean by more than a small superiority margin. The actual direction of the hypothesis depends on the response variable being studied.

Case 1: High Values Good, Superiority Test

In this case, higher values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that the treatment mean is greater than the reference mean by at least the margin of superiority. The null and alternative hypotheses are

\[ H_0: \frac{\mu_T}{\mu_R} \leq (1 + \epsilon) \quad \text{versus} \quad H_1: \frac{\mu_T}{\mu_R} > (1 + \epsilon) \]

\[ H_0: \ln(\mu_T) - \ln(\mu_R) \leq \ln(1 + \epsilon) \quad \text{versus} \quad H_1: \ln(\mu_T) - \ln(\mu_R) > \ln(1 + \epsilon) \]

Case 2: High Values Bad, Superiority Test

In this case, lower values are better. The hypotheses are arranged so that rejecting the null hypothesis implies that the treatment mean is less than the reference mean by at least the margin of superiority. The null and alternative hypotheses are

\[ H_0: \frac{\mu_T}{\mu_R} \geq (1 - \epsilon) \quad \text{versus} \quad H_1: \frac{\mu_T}{\mu_R} < (1 - \epsilon) \]

\[ H_0: \ln(\mu_T) - \ln(\mu_R) \geq \ln(1 - \epsilon) \quad \text{versus} \quad H_1: \ln(\mu_T) - \ln(\mu_R) < \ln(1 - \epsilon) \]

Test Statistics

The analysis for assessing non-inferiority and non-zero null hypotheses using higher-order cross-over designs is discussed in detail in Chapter 9 of Chow and Liu (2000). Unfortunately, their presentation is too lengthy to give here. Their method involves the computation of an analysis of variance to estimate the error variance. It also describes the construction of confidence limits for appropriate contrasts. One-sided confidence limits can be used for non-inferiority tests. Details of this approach are given in Chapter 3 of Chow et al. (2003). We refer you to these books for details.

Power Calculation

The power of the non-inferiority and superiority tests for the case in which higher values are better is given by

\[ Power = T_{\nu} \left( \frac{\ln(1 - \epsilon)}{\sigma_w \sqrt{b/n}} - t_{\nu, 1-\alpha} \right) \]

where \( T \) represents the cumulative \( t \) distribution, \( V \) and \( b \) depend on the design, \( n \) is the average number of subjects per sequence, and

\[ \sigma_w = \sqrt{\ln(COV^2_y + 1)} \]

The power of the non-inferiority and superiority tests for the case in which higher values are worse is given by

\[ Power = 1 - T_{\nu} \left( t_{\nu, 1-\alpha} - \left( \frac{-\ln(1 + \epsilon)}{\sigma_w \sqrt{b/n}} \right) \right) \]
The constants $V$ and $b$ depend on the design as follows:

<table>
<thead>
<tr>
<th>Design Type</th>
<th>Parameters $(V, b)$</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balaam’s Design</td>
<td>$V = 4n – 3$, $b = 2$.</td>
</tr>
<tr>
<td>Four-Period Design with Two Sequences</td>
<td>$V = 6n – 5$, $b = 11/20$.</td>
</tr>
<tr>
<td>Four-Period Design with Four Sequences</td>
<td>$V = 12n – 5$, $b = 1/4$.</td>
</tr>
</tbody>
</table>

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains the parameters associated with this test such as the means, sample sizes, alpha, and power.

**Solve For**

**Solve For**

This option specifies the parameter to be solved for from the other parameters. Under most situations, you will select either *Power* for a power analysis or *Sample Size* for sample size determination.

Select *Sample Size* when you want to calculate the sample size needed to achieve a given power and alpha level. Note that there are two choices for finding Sample Size. Select *Sample Size (Equal Per Sequence)* when you want the design to have an equal number of subjects per sequence. Select *Sample Size (Exact)* when you want to find the exact sample size even though the number of subjects cannot be dividing equally among the sequences.

Select *Power* when you want to calculate the power of an experiment.

**Test**

**Design Type**

Specify which cross-over design that you want to analyze. These designs allow you to compare two means: a treatment (A) and a reference (B). The designs assume that each subject is measured two or more times (or periods) with ample time in between to wash-out the effect of the treatment.

A sequence is an ordering of the how A and B are applied. For example, ‘ABA’ means that the subjects are measured three times: first treatment A, then B, then A again. Other possible sequences are BAB, AAB, and BBA. Each design includes several sequences.

The design tries to balance the experiment so that each treatment occurs an equal number of times and after each other treatment an equal number of times.

**Higher Means Are**

This option defines whether higher values of the response variable are to be considered better or worse. The choice here determines the direction of the test.

If Higher Means Are Better the null hypothesis is $R \leq 1+SM$ and the alternative hypothesis is $R > 1+SM$. If Higher Means Are Worse the null hypothesis is $R \geq 1-SM$ and the alternative hypothesis is $R < 1-SM$. 
Power and Alpha

Power
This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected.

Values must be between zero and one. Historically, the value of 0.80 (Beta = 0.20) was used for power. Now, 0.90 (Beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

Alpha
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

Sample Size

N (Total Sample Size)
This option specifies one or more values of the sample size, the number of individuals in the study (total subjects in all sequences). These values must be integers greater than one.

Effect Size – Ratios

SM (Superiority Margin)
This is the magnitude of the margin of superiority. It must be entered as a positive number.

When higher means are better, this value is the distance above one that is required for the mean ratio (Treatment Mean / Reference Mean) to be considered superior. When higher means are worse, this value is the distance below one that is required for the mean ratio (Treatment Mean / Reference Mean) to be considered superior.

R1 (Mean Ratio)
This is the value of the ratio of the two means (Treatment Mean / Reference Mean) at which the power is to be calculated.

When higher means are better, this value should be greater than 1+SM. When higher means are worse, this value should be less than 1-SM.

Effect Size – Coefficient of Variation

COV (Coefficient of Variation)
A response variable Y has mean μ_Y and standard deviation σ_Y. The coefficient of variation of Y, σ_Y/μ_Y, is used to specify the variation in Y.

Suppose that Y is skewed, so a logarithmic transformation will be applied. That is, the variable X = Ln(Y) will be analyzed using an appropriate ANOVA procedure. The analysis assumes that X is normally distributed with mean μ_X and standard deviation σ_X. So Y is lognormal and X is normal. Power and sample size calculations are made on X. However, interpretation may be easier in the Y scale.
If $Y$ is truly lognormal, there is a direct relationship between $\mu_Y$ and $\sigma_Y$ and $\mu_X$ and $\sigma_X$. Using this relationship, it can be shown that

$$COV_Y = \sqrt{\text{Exp}(\sigma_X^2)} - 1$$

Solving for $\sigma_X$, we obtain

$$\sigma_X = \sqrt{\ln(COV_Y^2 + 1)}$$

There are two ways to obtain a value for $COV_Y$.

1. Calculate $COV_Y$ directly from the mean and SD of a set of $Y$ values obtained from a previous (or pilot) study.
2. Obtain $\sigma_{wX}$ as the square root of the within mean square error in an ANOVA table of $X$. Then use the fact that $\sigma_X = \sigma_{wX}$.

We have found that method 1 does not provide a reliable estimate of $\sigma_X$, so we recommend method 2.
Example 1 – Finding Power

A company has developed a generic drug for treating rheumatism and wants to show that it is superior to a standard drug by a small amount. Balaam’s cross-over design will be used.

Researchers have decided to set the margin of superiority at 0.20. Past experience leads the researchers to set the COV to 0.40. The significance level is 0.05. The power will be computed assuming that the true ratio is 1.40. Sample sizes between 50 and 550 will be included in the analysis. Note that several of these sample size values are not divisible by 4. This is not a problem here because our main goal is to get an overview of power versus sample size. When searching for the sample size, we can request that only designs divisible by 4 be considered.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for the Ratio of Two Means in a Higher-Order Cross-Over Design procedure window by expanding Means, then Cross-Over (Higher-Order) Design, then clicking on Superiority by a Margin, and then clicking on the Superiority by a Margin Tests for the Ratio of Two Means in a Higher-Order Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Power</td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Design Type</td>
<td>2x4 (Balaam: AA</td>
</tr>
<tr>
<td>Higher Means Are</td>
<td>Better</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Total Sample Size)</td>
<td>50 to 550 by 100</td>
</tr>
<tr>
<td>SM (Superiority Margin)</td>
<td>0.2</td>
</tr>
<tr>
<td>R1 (Mean Ratio)</td>
<td>1.4</td>
</tr>
<tr>
<td>COV (Coefficient of Variation)</td>
<td>0.4</td>
</tr>
</tbody>
</table>

Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Power</th>
<th>Total Sample Size</th>
<th>Superiority Margin</th>
<th>Mean Ratio R1 (μT / μR)</th>
<th>Coefficient of Variation COV</th>
<th>Alpha</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.2507</td>
<td>50</td>
<td>0.200</td>
<td>1.400</td>
<td>0.4000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.5308</td>
<td>150</td>
<td>0.200</td>
<td>1.400</td>
<td>0.4000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.7207</td>
<td>250</td>
<td>0.200</td>
<td>1.400</td>
<td>0.4000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.8404</td>
<td>350</td>
<td>0.200</td>
<td>1.400</td>
<td>0.4000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9116</td>
<td>450</td>
<td>0.200</td>
<td>1.400</td>
<td>0.4000</td>
<td>0.050</td>
</tr>
<tr>
<td>0.9523</td>
<td>550</td>
<td>0.200</td>
<td>1.400</td>
<td>0.4000</td>
<td>0.050</td>
</tr>
</tbody>
</table>
References

Report Definitions
Power is the probability of rejecting H0 when H0 is false.
N is the total number of subjects. They are divided evenly among all sequences.
μT is the treatment mean. It is usually associated with the letter 'A' in the design.
μR is the reference mean. It is usually associated with the letter 'B' in the design.
SM is the magnitude of the margin of superiority. Since higher means are better, this value is positive and is the distance above one that is required to be considered superior.
R1 is the ratio of the means at which the power is computed.
COV is the coefficient of variation on the original scale.
Alpha is the probability of falsely rejecting H0 (falsely concluding superiority).

Summary Statements
In a superiority test on data for which higher values are better, drawn from Two-Period, Four-Sequence (Balaam) cross-over design, a total sample size of 50 achieves 25% power at a 5% significance level when the true ratio of the means is 1.400, the coefficient of variation is 0.4000, and the superiority margin is 0.200.

This report shows the power for the indicated scenarios.

Plots Section

This plot shows the power versus the sample size.
Example 2 – Finding Sample Size

Continuing with Example 1, the researchers want to find the exact sample size needed to achieve both 80% and 90% power.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the Superiority by a Margin Tests for the Ratio of Two Means in a Higher-Order Cross-Over Design procedure window by expanding Means, then Cross-Over (Higher-Order) Design, then clicking on Superiority by a Margin, and then clicking on the Superiority by a Margin Tests for the Ratio of Two Means in a Higher-Order Cross-Over Design. You may then make the appropriate entries as listed below, or open Example 2 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size (Exact)</td>
</tr>
<tr>
<td>Design Type</td>
<td>2x4 (Balaam: AA</td>
</tr>
<tr>
<td>Higher Means Are</td>
<td>Better</td>
</tr>
<tr>
<td>Power</td>
<td>0.8 0.9</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>SM (Superiority Margin)</td>
<td>0.2</td>
</tr>
<tr>
<td>R1 (Mean Ratio)</td>
<td>1.4</td>
</tr>
<tr>
<td>COV (Coefficient of Variation)</td>
<td>0.4</td>
</tr>
</tbody>
</table>

Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results

<table>
<thead>
<tr>
<th>Numeric Results for a Superiority Test of the Mean Ratio in a Two-Period, Four-Sequence (Balaam) Design</th>
</tr>
</thead>
<tbody>
<tr>
<td>Treatment Sequences: AA</td>
</tr>
<tr>
<td>Hypotheses: H0: R = (μT / μR) ≤ 1 + SM; H1: R = (μT / μR) &gt; 1 + SM</td>
</tr>
<tr>
<td>Higher Means are Better</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td>Power</td>
</tr>
<tr>
<td>0.8006</td>
</tr>
<tr>
<td>0.9003</td>
</tr>
</tbody>
</table>

When the equivalence margin is set to 0.20, we note that 430 subjects are needed to achieve 90% power and 311 subjects are needed to achieve at least 80% power.

Example 3 – Validation

This procedure uses the same mechanics as the Non-Inferiority Tests for the Ratio of Two Means in a Higher-Order Cross-Over Design procedure. We refer the user to Example 3 of Chapter 535 for the validation.